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The SMART Board™ 800 series interactive whiteboard features 

a touch-sensitive interactive surface and operates as part of a 

system that includes an integrated projector and a computer.

You can do everything you can do at your computer by 

touching the interactive surface with a pen tray pen or your 

finger, including:

	 •	 Opening and closing applications

	 •	 Conferencing with others

	 •	 Creating new documents or editing existing ones

	 •	 Visiting websites

	 •	 Manipulating objects

	 •	 Playing and manipulating video clips

Two users can also draw on the interactive surface at the 

same time, and you can use an array of touch gestures 

within applications. You can easily save your work for future 

reference and distribution.

You can find specific instructions on how to safely set up and 

use your interactive whiteboard at smarttech.com/us/Support/

Browse+Support.

Turning on your  
interactive whiteboard

Ensure that you’ve connected the USB cable between the pen 

tray and your computer and that the power cable is connected 

to a wall outlet, and then turn on your computer.

Note: The interactive whiteboard has its own power supply 

but it can also draw power from the computer. 

The Ready light, indicating the status of your interactive 

whiteboard, flashes green and then becomes solid green 

while the interactive whiteboard and the computer are 

establishing communication.

If your interactive whiteboard is in Standby mode, the Power 

button on the pen tray is amber. Press the Power button to 

wake up your interactive whiteboard.

Orienting your interactive whiteboard

After you install SMART Product Drivers on your computer and 

calibrate your interactive whiteboard, an orientation screen 

appears. The orientation process ensures that calibration 

coordinates are accurately associated with the relative location 

of the projected image on the interactive surface.

Orient your interactive whiteboard if your projector or 

interactive whiteboard has moved since you last used it, 

or whenever the mouse pointer isn’t properly aligned with 

your finger or a pen tray pen when you touch the interactive 

whiteboard’s surface.
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To orient your interactive whiteboard

	 1.	 Press the Orientation button on the pen tray. The  

		  orientation screen opens.

	 2.	 Pick up a pen from the pen tray

	 3.	 Begin at the upper-left corner of the screen, and touch  

		  the center of the target firmly with the tip of the pen.  

		  When you remove the pen, the target moves to the  

	 	 next orientation point. 

	 4.	 Repeat step 3 until you complete the orientation  

		  process. The orientation screen closes.

Note: You can re-orient a target by pressing the left arrow key 

on your keyboard, or the Keyboard or Right-click buttons on 

the pen tray.

Using the pen tray

The SMART Board 800 series interactive whiteboard features 

a modular pen tray with an intuitive new design. Along with 

two pens and an eraser, the pen tray includes six pen tray 

buttons that activate pen colors and the on-screen keyboard, 

as well as the Right-click, Orientation and Help functions.

© 2011 SMART Technologies ULC. All rights reserved. SMART Table, SMART Notebook, SMART Document Camera, smarttech, the SMART logo and all taglines are trademarks or registered trademarks of  
SMART Technologies ULC in the U.S. and/or other countries. Printed in Canada 09/2011.

The pens

There are two pens included with your interactive whiteboard. 

Pick up a pen and press one of the four color buttons on the 

pen tray to select the color of digital ink.

Writing and erasing notes 

To write over your desktop or an application, pick up a pen 

from the pen tray and write on the interactive whiteboard. 

Pick up the eraser from the pen tray and move it in a smooth 

motion over your notes to erase them.

Testing the Internet browser and the 
on-screen keyboard

Before delivering a presentation it’s a good idea to test 

the basic functionality of your Internet browser and the  

on-screen keyboard.

	 1.	 Using your finger, double-press the Internet browser  

		  icon (e.g., Microsoft® Internet Explorer®) on the desktop  

		  to open a web page

	 2.	 Press the On-screen Keyboard button on the pen tray

	 3.	 Press once inside your Internet browser’s address bar to  

		  select the website address.

	 4.	 Using the on-screen keyboard, type a web address

Note: The on-screen keyboard is a single point of contact tool. 

Touch-typing or keystroke combinations are not possible. 

	 5.	 Press the Go button beside the address bar

On-screen keyboard Right click
The middle four pen tray buttons change 

the color of digital ink for the two pen tools 
(black, red, green or blue).
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Introduction
SMART Meeting Pro™ Premium includes integrated  
SMART Bridgit™ collaboration functions as part of a  
client/server application that lets you share applications and 
information with anyone, anywhere in the world.

When you install SMART Meeting Pro Premium, you’re asked 
to provide information about the SMART Bridgit Server that 
you and other meeting members use to connect to each 
other. When you start SMART Meeting Pro Premium, it 
automatically creates a meeting as indicated by the name 
and password in the SMART Bridgit Collaboration Bar at the 
top of the screen.

Participants (remote or local) use the meeting name and 
password to join your meeting. When your meeting 
participants are connected, you can share your screen with 
them so that everyone can see and work with the same 
information, at the same time.

In this lesson you will learn how to:

•	 Create a meeting with SMART Meeting Pro Premium
•	 Invite meeting participants
•	 Share your screen
•	 Join a meeting with SMART Bridgit client software

The SMART Bridgit Collaboration Bar
The SMART Bridgit Collaboration Bar contains all of the 
information and tools you need to join, host and control 
your collaborative meetings. SMART Meeting Pro Premium 
creates a new password each time it starts, but you can 
easily change the meeting name and password to suit your 
preference.

Creating a Meeting
SMART Meeting Pro Premium automatically creates a 
meeting when it starts, or after you press Reset Room on 
the toolbar. As a meeting host, all you need to do to create a 
meeting is communicate the meeting name and password to 
the participants and share your screen with the participants 
once they have joined.

To e-mail meeting details

1.	� Select Menu > E-mail Invitation to Others from 
the SMART Bridgit Collaboration Bar.  
The Send E-mail Invitation window appears.

2.	� Type the desired information in the  
appropriate fields

3.	 Press Send

To share your screen

1.	� Press      Share Screen on the SMART Bridgit 
Collaboration Bar. Preparing to share your desktop. 
Please wait… appears on your screen briefly.

2.	� A thin blue border appears around your screen 
indicating that your screen is being shared

NOTE: The SMART Bridgit collaboration feature connects 
meeting participants through a SMART Bridgit Server. This 
feature is only available if the meeting host has access 
to a SMART Bridgit Server. For more information about 
SMART Bridgit Servers, refer to the SMART Bridgit System 
Administrator’s Guide.

NOTE: To stop sharing your screen, press Stop Sharing  
on the SMART Bridgit Collaboration Bar.

NOTE: To change the meeting name and password, select 
Menu > Change Meeting Name and Password from the 
SMART Bridgit Collaboration Bar, enter your new meeting 
information and press OK.

Number of
participants in
the meeting

PasswordMeeting 
Name

Share/Stop
Sharing Screen 
button

SMART Bridgit
collaboration
menu

SMART Bridgit
Collaboration
Bar slider

Recipient 
e-mail  
address

Message
text box

Download 
link

Meeting
details
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Joining a Meeting with  
SMART Bridgit Client Software
SMART Meeting Pro Premium integrates with SMART Bridgit 
software to connect meeting participants. Participants that 
want to join your SMART Meeting Pro Premium meeting 
(either locally or remotely), download and install  
SMART Bridgit client software on their computer or laptop, 
and use it to connect to your meeting.

To download and install SMART Bridgit client software

1.	� Click the download link in the e-mail invitation you 
received from the meeting owner. A File Download 
window appears.

2.	 Click Save. The Save As dialog box appears.

3.	� Select the Desktop as the file save location, and then 
click Save. A SMART Bridgit icon is created on  
the Desktop.

To join a meeting with SMART Bridgit client software

1.	� Double-click the  
SMART Bridgit  
desktop icon. The  
SMART Bridgit  
Software dialog  
box appears.

2.	 Type your name in  
	 the Your name  
	 text box

3.	� Select the name of the meeting from the  
Meeting name drop-down menu

4.	 Type the password in the Password text box

5.	 Select your preferred audio settings

6.	 Click Join Meeting

Joining Another Meeting with 
SMART Meeting Pro Premium
You can easily connect to another meeting using  
SMART Meeting Pro Premium. This is particularly useful for 
team projects, multiple site meetings, or if you have more 
participants than a single meeting room can accommodate.

To join another meeting with  
SMART Meeting Pro Premium

1.	 Select Menu > Join Another Meeting. 
	 The SMART Bridgit Software dialog box appears.

2.	� Type your name or location in the Your name  
text box

3.	� Select the name of the meeting from the  
Meeting name drop-down menu

4.	 Type the password in the Password text box

5.	 Press Join Meeting

Conclusion

 

You can use SMART Meeting Pro Premium to collaborate 
with local or remote meeting participants.

In this lesson you have learned how to:

•	 Create a meeting with SMART Meeting Pro Premium

•	 Invite meeting participants

•	 Share your screen

•	 Join a meeting with SMART Bridgit client software

For more information about  
SMART Meeting Pro Premium, visit  
http://www.smarttech.com/us/Resources/Training/
Training+Search+Pre-filter

NOTE: To connect to a different server, click the      button. 
The server information dialog box appears. Select the 
Server name from the drop-down menu, or type the server 
name in the text box and click Connect.

Your 
name
text box

Password
text box

Meeting
name 
menu
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Introduction
The Whiteboard mode in SMART Meeting Pro™ Premium 
allows you to capture notes and drawings in digital ink 
on your SMART product. Use Whiteboard mode for 
brainstorming, note taking and other activities that involve 
your SMART product’s digital ink tools.

You can access Whiteboard mode at any time by
pressing      Whiteboard on the toolbar.

In this lesson you will learn how to:

•	 Modify the Whiteboard mode interface
•	 Create and open a Whiteboard file
•	 Create and erase meeting notes
•	 Navigate Whiteboard pages
•	 Add and delete Whiteboard pages
•	 Save and e-mail your Whiteboard file
•	 Reset the room

Presenting in Whiteboard Mode
You can use the following features to modify the 
Whiteboard mode interface when you’re presenting, or if 
you want a larger drawing area:

•	 Collapse the toolbar by pressing 
•	 Restore the toolbar by pressing      
•	 �Move the toolbar to the right or left of the screen  

by pressing
•	 �Switch to full screen by pressing         in the  

top-right corner of the screen
•	 �Exit full screen by pressing         in the top-right 

corner of the screen

Creating a New Whiteboard File
You can save your digital meeting notes as a Whiteboard  
file. You can open, view, edit and share this file at  
your convenience. SMART Meeting Pro Premium 
automatically creates a new Whiteboard file when it starts, 
but you can create a new Whiteboard file at any time.

To create a new Whiteboard file
	 Select File > New from the  
	 Whiteboard menu.

Opening a Whiteboard File
You can save your Whiteboard file with a .notebook file  
extension. If you want to work with a Whiteboard file that 
you previously saved, simply open the .notebook file. 

To open .notebook files

1.	 Select File > Open from  
	 the Whiteboard menu.  
	 The Open dialog  
	 box appears.

2.	 Browse to and select  
	 the .notebook file you  
	 want to open

3.	 Press the Open button

This is particularly useful if you want to save notes	for a 
recurring meeting in the same file, or if you’d like to review 
previous meeting notes.

Drawing
Area

Page
Sorter

Whiteboard
Menu

Toolbar

NOTE: You can also open your Microsoft® PowerPoint® files 
in SMART Meeting Pro Premium by selecting your  
PowerPoint file from the Open dialog box. 

Note that some PowerPoint features are not supported by  
SMART Meeting Pro Premium.
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Creating Meeting Notes
Create digital meeting notes quickly and easily.

To write/ draw notes

1.	 Pick up a pen from your  
	 SMART product’s pen tray

2.	 Select a color and thickness

3.	 Write in the drawing area

Erasing Meeting Notes
Erase digital meeting notes quickly and easily.

To erase notes

1.	 Pick up the eraser from  
	 your SMART product’s  
	 pen tray

2.	 Select the eraser size

3.	 Erase your digital  
	 ink notes

Navigating Pages
You can use the Page Sorter to easily navigate the pages in 
your Whiteboard file.

Page Sorter functions:

•	 Select a page by pressing the page thumbnail 
•	 Select the next page in the file by pressing 
	 Next Page
•	 Select the previous page in the file by pressing 
	 Previous Page
•	 If you have many pages in your file, you can scroll 		
	 through the page thumbnails by pressing the 
	 arrow buttons
•	 �Rearrange pages by pressing and dragging the page 

thumbnails in the Page Sorter

Adding a Page to Your  
Whiteboard File
One of the great advantages of SMART Meeting Pro 
Premium is the limitless supply of pages. Simply add another 
page to your Whiteboard file when you need more space  
to write.

To add a blank page

	 Press     in the Page Sorter.  
	 A blank page appears.

Deleting a Page From  
Your Whiteboard File
If you want to remove some of your notes, you can easily 
delete a page from your Whiteboard file.

To delete a page

1.	 Select the thumbnail of the page you want  
	 to delete.

2.	 Press     in the Page Sorter. A confirmation
	 dialog box appears.

3.	 Press OK  

Saving Your Whiteboard File
You can save your Whiteboard file as a SMART Notebook, 
Microsoft PowerPoint, Web Page, Adobe® PDF Document  
or Graphic file. 

To save your Whiteboard file

1.	 Select File > Save As from the 
	 Whiteboard menu

2.	 Select a name and location to save your file

3.	 Select a file type from the Save as type  
	 drop-down menu

4.	 Press Save
Add Page Page Thumbnail

Arrow ButtonNext Page

Delete Page

Previous Page

Eraser
size

NOTE: If you are viewing Whiteboard mode in full screen, 
the Next Page and Previous Page buttons are located on 
the toolbar and you are unable to add or delete pages.

Thickness

Color
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E-mailing Your Whiteboard File
You can e-mail your meeting notes quickly and easily to 
any recipient you want. Send the meeting notes to meeting 
participants instantly so that everyone has a copy, or 
distribute them to anyone who was absent.

To e-mail your Whiteboard file

1.	� Select Send To > Mail Recipient (as Attachment). 
The Attachment dialog box appears.

2.	 Type a file name in the File name text box

3.	 Select a file type from the File type drop-down menu

4.	� Press OK. The Send as Attachment dialog  
box appears.

5.	 Type the desired information in the appropriate fields

6.	 Press Send

Resetting the Room
Press the Reset Room button on the toolbar to close all 
programs and files that you used in your meeting.  
SMART Meeting Pro Premium is then ready for the  
next meeting.

To reset the room

1.	 Press    Reset Room on the toolbar. 
	 The Reset Room dialog box appears.

2.	 Press Reset Room

3.	 You are prompted to save any open files  
	 before closing

NOTE: Resetting the room closes all programs and files  
that you opened on the computer after you started  
SMART Meeting Pro Premium.

Conclusion

 

Use Whiteboard mode in SMART Meeting Pro Premium to 
capture your digital ink meeting notes.

In this lesson you have learned how to:

•	 Modify the Whiteboard mode interface

•	 Create and open a Whiteboard file

•	 Create and erase meeting notes

•	 Navigate Whiteboard pages

•	 Add and delete Whiteboard pages

•	 Save and e-mail your Whiteboard file

•	 Reset the room

For more information about  
SMART Meeting Pro Premium, visit  
http://www.smarttech.com/us/Resources/Training/
Training+Search+Pre-filter

© 2010 SMART Technologies ULC. All rights reserved. SMART Meeting Pro, SMART Bridgit, 
SMART Board, smarttech and the SMART logo are trademarks or registered trademarks of SMART 
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Writing notes over websites 
and applications
Use your finger or the Cursor tool to open a website,  
document or application just as you would on your 
computer. You can write and draw digital ink notes over 
the display. Refer to the section titled Working in Desktop 
mode for instructions on using your finger to interact with 
programs and applications.

To write notes over 
websites and applications

1.	 Double-press your 
	 Internet browser, 
	 file or application icon 
2.	 Pick up a pen from 
	 your SMART product’s 
	 pen tray
3.	 Select a color and thickness
4.	 Write over the website, file or application

Capturing notes to your notes file
When you write over websites and applications that are not 
Ink Aware, you can capture an image of the screen to your 
notes file using the Digital Ink Layer. Refer to the  
section titled Using Ink Aware for a listing of Ink Aware  
applications, and instructions on using Ink Aware tools.

When you make a note on any application that isn’t Ink 
Aware, the Digital Ink Layer appears, as indicated  
by the frame around the screen.

Press Capture   	 	    on the toolbar and select one of 
the three options to capture your notes to a new page in 
your notes file.

TIP: Press the Close      button 
in the top-right corner of the 
screen to close the Digital Ink 
Layer. Press the Clear       
button to clear all your digital 
ink notes from the screen.

Introduction
You can use SMART Meeting Pro™ and your SMART  
interactive product to work with any program or application 
on your computer. Open files, websites or programs and 
write digital notes that you can capture to your notes file.

You can access the  
desktop at any time by 
pressing     Desktop on  
the toolbar.

Working in Desktop mode
When you’re working in Desktop mode, you can use  
your finger as your mouse to interact with programs  
and applications. 

To left-click
With the pens and eraser in the pen tray, a press with your 
finger is the same as a left-click with the mouse. Simply 
double-press to perform a double-click.

To right-click

1.	� Press the Right-Click button on your  
interactive product

2.	 Press the screen

OR

1.	� Press and hold your finger on the screen for  
3 seconds

NOTE: Your next contact on the interactive screen is a 
right-click. Subsequent presses revert to a left-click.
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In Microsoft Office 2010, 
you have the option of 
using the application’s ink 
tools.  Select Use This 
Application’s Tools from the 
Settings menu to 
activate the application’s 
ink tools.

SMART Technologies

Using Ink Aware
SMART Meeting Pro integrates with many popular  
third-party word processing, graphics, Tablet PC,  
presentation and conferencing applications. When you use 
an Ink Aware application you can inject your digital ink notes 
directly into the file, rather than over the file. Refer to the 
section entitled Ink Aware applications list for a listing of  
Ink Aware applications.

When you write in Microsoft® Excel®, Word or  
PowerPoint®, the Aware Tools toolbar appears either as a 
floating toolbar, or at the top of the screen with the  
application’s other toolbars.

•	 Press           to insert your digital ink notes into the 	
	 document as a graphic. Your notes behave like any 	
	 other graphic in your file.

•	 Press           to convert your digital ink notes to 	 	
	 typed text, and insert them at the cursor position. 		
	 The typed text appears in the same color as 		
	 the digital ink notes.

•	 Press           to take a screen capture of your digital 	
	 ink notes and the underlying application. The screen 	
	 capture appears on a new page in your  
	 notes file.

•	 Press 	 	  to modify Ink Aware settings

Ink Aware applications list
The following applications are Ink Aware:

•	 Microsoft Word (all versions through 2007)

•	 Microsoft Excel (all versions through 2007)

•	 Microsoft PowerPoint (all versions through 2007)

•	 Microsoft Visio® (2002 and 2003 versions)

•	 Adobe® Acrobat® Pro (version 6.0, 7.0, 8.0 and 9.0)

The following applications require  
SMART Product Drivers 10.7:

•	 Microsoft Word 2010

•	 Microsoft Excel 2010

•	 Microsoft PowerPoint 2010

•	 Microsoft Visio 2010

•	 Microsoft OneNote® 2010

NOTE: If you have Microsoft Office 2007 or 2010 the 
Aware Tools toolbar is integrated into the Microsoft Ribbon 
interface under the Add-Ins tab.
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Introduction
When software is Ink Aware, you can write and draw directly 
into an active file. When you save an Ink Aware application 
file, your notes and drawings will be visible the next time you 
open it. Microsoft® Word, Excel® and PowerPoint® software 
are the most commonly used Ink Aware applications.

Microsoft Word and Excel Software
When using Microsoft Word or Excel software with your 
interactive whiteboard, you will notice three new buttons. 
They may be integrated with the current toolbar or 
separated as a floating toolbar.

1.	� Press to insert your drawing or writing as an image 
directly into your document

2.	� Press to convert your writing as typed text directly 
into your document. Your text will appear at the 
cursor point or in the selected cell and in the color 
the words were written.

3.	� Press to save a screen capture in SMART NotebookTM 
software

PowerPoint Software
When you are presenting a slide show with PowerPoint 
software on your interactive whitebaord, you can save your 
notes as images and save screen captures to  
SMART Notebook software, just as you can when using 
Microsoft Word or Excel software. Use the Slide Show 
toolbar to access the Ink Aware features of PowerPoint 
software. The Slide Show toolbar appears automatically 
when you run a PowerPoint slide show.

TIP: You can advance to your next PowerPoint slide by 
pressing twice on your interactive whiteboard, ensuring your
second press is to the right of the first. To go to the previous 
slide, make the second press to the left of the first.

The Command Menu
Press the center button on the Slide Show toolbar to open 
the Command menu. The Command menu includes the 
following options.

Select Function
Capture to  
SMART Notebook

Capture an image of the current slide to  
SMART Notebook software

Insert Drawing  
as Image

Save your notes directly into your PowerPoint 
software presentation

Clear Drawing Delete your notes from the page

Add Blank Slide Add an additional slide to your presentation

PowerPoint  
Commands

Open the PowerPoint Commands submenu

Settings Open the Settings submenu

SMART Floating Tools Open the Floating Tools toolbar

End Show End the Slide Show

Slide Show toolbar

Go to the next slide
of your presentation

Go to the previous slide  
of your presentation

Open the Command Menu

Example: Pressing the Insert as Text button

Before you press the button, 
the image is not part 
of the file.

Press the button and the 
image becomes part of the 
Microsoft Excel software file.

Select the cell 
you would like 
to edit.

After pressing 
the Insert as Text 
button, your 
writing appears  
in the selected 
cell as text.

Integrated with the toolbar Separated as a floating toolbar

1. 2. 3. 1. 2. 3.

©2010 SMART Technologies ULC. All rights reserved. SMART Board, SMART Notebook, smarttech and the SMART  
logo are trademarks or registered trademarks of SMART Technologies ULC in the U.S. and/or other countries. Microsoft, 
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countries. Printed in Canada 03/2010.
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Introduction
Before you begin your meeting, ensure that your computer is 
turned on and the SMART Board™ interactive whiteboard is 
connected and oriented.

This lesson assumes you have a basic understanding of the 
Microsoft® Windows® operating system. You may find it 
useful to think of how you normally work with a computer 
as you go through the lesson. When working at your 
computer, for example, you use left-, right- or double-clicks, 
depending on the function you want to perform. Use the 
SMART Board interactive whiteboard in the same way. If you 
get confused, simply think about what you would do at your 
computer, and then replicate these actions on the
interactive whiteboard.

What Is Ink Aware?
Ink Aware integrates SMART Board software with many 
types of applications, including Microsoft Word, Excel® or 
PowerPoint®. When you use an application that is Ink Aware, 
whatever you write or draw on your interactive whiteboard 
becomes embedded in the file, rather than an external note 
created over the file.

SMART Aware Toolbar
When using Microsoft Excel with your interactive 
whiteboard, you will notice three new buttons appear; they
may be integrated with the current Excel toolbar or 
separated as a floating toolbar.

1.	� Press to insert your drawing or writing as an image 
directly into your document

2.	� Press to convert your writing as typed text directly 
into your spreadsheet. Your text will appear at the 
cursor point or in the selected cell and in the color 
the words were written.

3.	� Press to save a screen capture in SMART NotebookTM 
software

4. 	� Press to select the option to automatically insert the 
drawing as an image

If you do not see this toolbar, select View > Toolbars > 
SMART Aware Toolbar in Microsoft Excel.

Preparation
1.	  �Open a blank spreadsheet  

in Microsoft Excel

2.	  �Type Hotel in cell A2 

3.	  Type Flight in cell A3

4.	  Type 1000 in cell B3

Using Ink Aware in the Office
Assume you and your colleagues are attending a conference 
in the near future. As a group, you prepared a travel request 
outlining the anticipated expenses. This request will be 
presented to the accounting department for approval.

1.	� One group member states the hotel will cost $150 
per night. Press the cell in the spreadsheet to 
highlight where the cost will be placed. Pick up a 
pen from the SMART Pen Tray and write 150 on the 
interactive whiteboard.

2.	� Another group member declares the corporate 
rate for the hotel is only $115 per night. Put the 
pen back in the pen tray and press once on the 
interactive whiteboard to remove 150. Press the cell 
in the spreadsheet to highlight where the new cost 
will be placed. Now, write 115. 

Integrated with the toolbar

1. 2. 3. 4.



Ink Aware and Microsoft Excel in the Office

SMART Technologies Mar 2010

©2010 SMART Technologies ULC. All rights reserved. SMART Board, SMART Notebook, smarttech and the SMART 
logo are trademarks or registered trademarks of SMART Technologies ULC in the U.S. and/or other countries. Microsoft, 
Windows, Excel and PowerPoint are registered trademarks of Microsoft Corporation in the United States and other 
countries. Printed in Canada 03/2010.

3. 	� Press the Insert as Text button to add the hotel rate 
into the highlighted cell. Your text is inserted into 
the spreadsheet and appears in the same color as 
the digital ink.

4. 	� Finally, your team lead suggests that you get a 
minimum of three price quotes for the flight. Circle 
the flight cost in cell B3 and write Get Quote. Press 
the Insert as Image button to insert your note as 
an image into your spreadsheet.

5. 	� Save your spreadsheet as a Microsoft Excel file. Now 
you can update the travel request with your group’s 
notes and e-mail it to the accounting department 
for approval.

Congratulations!
You have completed the Ink Aware and Microsoft Excel in 
the Office lesson.
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Using Microsoft Visio software with SMART Board software 
Ink Aware applications recognize which area of the software is the active work area and which area is used for buttons and 
toolbars. Microsoft® Visio®  software is one of the many Ink Aware applications recognized by SMART Board™ software. 

Stencils and toolbars
Stencils and toolbars in Visio software 
function the same way on a SMART 
brand product as they do when being 
viewed on a computer monitor.

To drag a shape to the drawing page 
while working at your computer, select it 
from a stencil with your mouse and drag 
it to the drawing page. When using a 
SMART Board interactive whiteboard, 
select the shape with your finger and drag 
it to the drawing page. Manipulate 
shapes on the drawing page with your 
finger the same way you would if you 
were using your mouse. 

To select a tool from one of Visio 
software’s toolbars while at an interactive 
whiteboard, press the associated button 
with your finger.

NOTE: If you are using one of SMART’s 
pen display products, use the tethered 
pen to drag shapes to the drawing area or 
select buttons from Visio software’s 
toolbars.

Using the pen tools
When you pick up a pen tool from the SMART Pen Tray or press a pen 
button on an interactive pen display, Visio software automatically switches 
to the Freeform tool. For some people, drawing freeform shapes with a 
pen tool provides greater dexterity of movement than a mouse.

Visio software also matches the color, width and transparency of the 
selected pen tool to the Freeform tool. For example, if you select the red 
pen tool, then the color of the lines you draw with the Freeform tool will be 
red.

When you put a pen tool back in the pen tray or select the pointer button on 
an interactive pen display, Visio software will automatically select the Pointer 
tool. 

Instead of using your mouse, select a shape with your finger or pen tool and drag it to the 
drawing page.

Visio software automatically matches the color, width and 
transparency of the Freeform tool to that of a pen tool from 
the SMART Pen Tray.



Getting Started with Your 
SMART Board™ 8070i Interactive Display

SMART Technologies Sept 2011

Your SMART Board™ 8070i interactive display features 

SMART’s proprietary DViT™ (Digital Vision Touch) technology 

on an LCD screen which enables you to select, write and erase 

on the interactive surface. The interactive display operates as 

part of a system that includes a computer or a collaboration 

appliance system.

You can do everything you can do at your computer by 

touching the interactive surface with a pen tray pen or your 

finger, including:

	 •	 Opening and closing applications

	 •	 Conferencing with others

	 •	 Creating new documents or editing existing ones 

	 •	 Visiting websites 

	 •	 Manipulating objects 

	 •	 Playing and manipulating video clips

Two users can also draw on the interactive surface at the same 

time, and you can use an array of gestures within applications. 

You can easily save your work for future reference and 

distribution.

You can find specific instructions on how to safely set up and 

use your interactive display at smarttech.com/us/Support/

Browse+Support.

Turning on and turning off your 
interactive display

To turn on your interactive display

	 1.	 Ensure the interactive display is connected to a  

		  computer or collaboration appliance and the main 		

		  power switch is turned on

	 2.	 Turn on your computer

	 3.	 Press the power button on the front control panel.

	 	 OR

	 	 Press the POWER ON button on the remote control.

		  Your computer’s logon screen or desktop appears on 	

		  your interactive display.

To turn off your interactive display

	 1.	 Shut down your computer

	 2.	 Press the power button on the front control panel.

	 	 OR

	 	 Press the STANDBY button on the remote control.

Using the infrared remote control
The infrared remote control enables you to turn on and 

turn off your interactive display, change the input source, 

change the volume, and more. You can also use the remote 

control to open the on-screen menu, and then change the  

monitor’s settings.

Power button
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Orienting your interactive display
When the location of your touch is misinterpreted (a pointer 

appears at a distance from the actual contact), orient your 

interactive display.

To orient the interactive display

	 1.	 Press the orientation button on the color  

		  select module.

	 	 OR

		  Complete the calibration process (see user’s guide).

		  The orientation window opens.

	 2.	 Use an interactive display pen to press the red targets 	

		  as they appear. Hold the tip of the pen at the center 	

		  of each target until the target turns green, and then 	

		  lift the pen. When you lift the pen, the target moves 	

	 	 to the next orientation point.

	 3.	 Continue until you’ve pressed all the targets.

		  The orientation window closes.

If this does not correct inaccurate touch control, calibrate 

your interactive display following the instructions in the  

SMART Board 8070i Interactive Display User’s Guide. 

Using the pen tray
The pen tray provides easy access to all of the tools you need 

to use the interactive display.

Pen and eraser holders

The bottom bezel contains magnetic holders for two pens 

and an eraser. Removing a pen or the eraser from the holders 

activates it and enables you to either draw or erase digital ink.

Color select module

The color select module enables you to access the help 

function, open the on-screen keyboard, select pen color, 

activate the right-click and orient the interactive display.

Working with Ink Aware programs
Many popular third-party programs are Ink Aware (that is, 

they’re integrated with SMART Product Drivers). If a program 

is Ink Aware, whatever you write or draw on the interactive 

product becomes a component of the program file. 

	

Ink Aware software products include Microsoft® Word, Excel® 

and PowerPoint®. You can open and view a list of Ink Aware 

programs in the SMART control panel.

© 2011 SMART Technologies ULC. All rights reserved. SMART Board, DViT, smarttech, the SMART logo and all 
SMART taglines are trademarks or registered trademarks of SMART Technologies ULC in the U.S. and/or other 
countries. All other third-party product and company names may be trademarks of their respective owners.  
Printed in Canada 09/2011.

Help

On-screen 
keyboard

Pen color button Right-click

Orient the display



SMART Podium™ 500 series
interactive pen display with
SMART Meeting Pro™ software

Overview
Using your SMART Podium™ interactive pen display with SMART Meeting Pro™ software, you can
write, draw and capture digital ink notes. You can also use the illuminated buttons on the interactive
pen display and the tethered pen to click objects on the screen and operate your computer.

g To write digital ink in SMART Meeting Pro software

1. PressWhiteboard on the SMART Business Toolbar to access the drawing area.

2. Press Pen , select a line type, and then write or draw digital ink using the tethered pen.

T   T I P

SMART Meeting Pro software has a variety of writing and drawing tools for creating
presentations. See the SMART Meeting Pro software online Help for more information.

g To write digital ink over your desktop and applications

1. Press Desktop on the SMART Business Toolbar to access your desktop.

2. Press aPen Color button on your interactive pen display.

A transparent layer appears over your desktop.

3. Write or draw digital ink across the screen using the tethered pen.

Getting started



GET T I N G ST A R T ED

SMART Podium 500 series interactive pen displaywith SMART Meeting Pro software

g To capture your notes

Press Capture from the illuminated button panel, and then select one of the following options.

Button Description
Press Area Capture to take a screen capture of a specific area.

PressWindow Capture to take a screen capture of a window.

Press Full Screen Capture to take a screen capture of your entire screen.

Press Freehand Capture to take a screen capture of a freehand-selected area.

Each screen capture appears in the drawing area of SMART Meeting Pro software.

g To control your computer

Use the illuminated buttons and the tethered pen to perform the following actions.

Action Description
Left-click an
object

Press theSelect button, and then press the tethered pen to the screen.

Double-click
an object

Press theSelect button, and then quickly press the tethered pen to the screen

twice.
Right-click
an object

Press theRight Click button, and then press the tethered pen to the screen.

Move an
object

1. Press theSelect button.

2. Press and hold the object on the screen with the tethered pen.

3. Move the pen across the screen.

4. When you reach the position you want to move the object to, lift the pen from
the screen.

smarttech.com/support
smarttech.com/contactsupport
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